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  نويسندگانمقدمة 
آرمـه    ها و دالهـاي بـتن        براي تحليل و طراحي پي     SAFE ةمهندسان طراح سازه در سالهاي اخير از برنام       

 بـا   . اسـت  ETABSافزار، امكان ارتباط بـين آن و برنامـه            يكي از مزاياي اصلي اين نرم     . اند  استفاده كرده 
 تحليل و طراحي كـرده و نتـايج         ETABSبرنامه  تواند سازه اصلي را در         كاربر مي  ،استفاده از اين قابليت   

 منتقـل   SAFEاي، به برنامـه       نيرو و يا تغييرمكانهاي دالها را به منظور تحليل و طراحي اين اعضاي سازه             
  .كند

يكي از مسائل اصلي كه مهندسان در هر پروژه و پس از پايان عمليات تحليل و طراحي سازه بـا آن                   
 مـسئله   ،اين فاز از هر پروژه    . رايي بر مبناي محاسبات انجام گرفته است      هاي اج   روبرو هستند، تهيه نقشه   

در . باشـد   ها كمتر از اهميت محاسبات صورت گرفته نمـي          حساسي بوده و اهميت دقت در ترسيم نقشه       
بايست قادر به توجيه    نقشه زبان گوياي نتايج انجام گرفته بوده و بدون نياز به مهندس محاسب مي،واقع

بـراي ترسـيم    اي متعـددي      هـاي رايانـه     گويي به ايـن نيـاز، برنامـه         به منظور پاسخ  . ارگاه باشد خود در ك  
افزارهاي جانبي در داخل برنامـه        افزارها به صورت نرم     برخي از اين نرم   . اند  هاي اجرايي ايجاد شده     نقشه

AutoCad                 از . دهنـد   مـي  به ترسيم نقشه پرداخته و برخي ديگر به صورت مستقل اين عمليات را انجـام
اشـاره  ... ،Tekla Structure ،ProSteel ،Hyper Steel ،AutoPlant Structural  بهتوان افزارها مي اين نرم
  .نمود

هـا و دالهـا، يـك         هاي اجرايي مربوط به پـي        به منظور رفع نياز مهندسان و ترسيم نقشه        CSIشركت  
Plug-in با نام CSiDETAILERهاي جديد  خهاين برنامه در نس.  توسعه دادSAFE 8.x  قرار داده شـده 

 اگـر   .باشـد   ها و دالهاي طراحي شده مـي        هاي اجرايي پي    قادر به ترسيم نقشه    ACIبر اساس آيين نامه     و  
بايست انتظار داشـته باشـد تـا     باشد، اما كاربر نمي هاي اوليه اين برنامه داراي ضعفهايي نيز مي       چه نسخه 

دلخواه را به عنوان خروجي از برنامه      صد در صد    د نظر، يك نقشه     عليرغم تنظيم صحيح پارامترهاي مور    
هـاي     در برنامه به كاربر كمك خواهد كرد تا خروجيExport to .dwg/.dxfوجود قابليت . دريافت كند

 نيز خاطر CSIدر اين مورد شركت .  ويرايش كندAutoCadهايي نظير    بدست آمده از برنامه را در برنامه      
بايست آنهـا     هاي بدست آمده از برنامه بوده و درصورت نياز مي           نشان كرده كه كاربر مسئول كنترل نقشه      

  .را ويرايش كند
نـام دارد،  " SAFE- CSiDETAILERآرمه  هاي بتن  تحليل و طراحي دالها و پي"در كتاب حاضر كه 

نظـر  ، صـرفاً    نحـوة حـل مثالهـا     . بيـان شـده اسـت     قابليتهاي برنامه همراه با ارائه مثالهاي مختلـف           كليه  

 سه



پاسخهاي ممكن است   نويسندگان بوده و چنانچه كاربر پارامترهاي برنامه را مطابق نظر خود تنظيم كند،              
  :اند مطالب اين كتاب در هشت فصل به صورت زير ارائه شده. ديگري بدست آورد

  CSiDETAILERمحيط گرافيكي برنامة : فصل اول •
  لاحات، محيط گرافيكي برنامه و دستورات منوهااصط: فصل دوم •
  مدل ترسيم اندازي راه: فصل سوم •
  ايجاد و اضافه كردن نماها: فصل چهارم •
  مديريت نماها و ترسيمات: فصل پنجم •
  هاي عمومي جداول و توصيه: فصل ششم •
  خروجي: فصل هفتم •
  مثالها: فصل هشتم •

و ساير كساني كه هـر يـك    كريمي فراهاني  مهندس علي قرباني، مهندس سعيد  اننويسندگان از آقاي  
  . نمايند به نحوي آنها را در تنظيم و ارائه اين مجموعه ياري دادند تشكر و قدرداني مي

با اين . اي كم نقص تقديم خوانندگان نمايند     اند تا مجموعه     تمام سعي خود را بكار گرفته      نويسندگان
ي مكرر، در برخي از قـسمتهاي كتـاب نواقـصي           ها  وجود امكان دارد كه عليرغم تصحيحات و ويرايش       

 از نظرها و پيشنهادهاي كلية خوانندگان گرامي كه در بهبود مجموعـة             نويسندگانلذا  . وجود داشته باشد  
 info@elme-omran.comي  ت ـآدرس اينترن دريافت آن از طريـق       آمادة حاضر مفيد باشد استفاده كرده و     

  .باشند مي
  

  دي داودنبيسيد مه   ١٣٨٥ بهار ‐ تهران
  سيد مهيار لاجوردي  

 چهار
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  فصل اول
 CSiDETAILER محيط گرافيكي برنامة

  
  
  
  
  
   مقدمه‐۱‐۱

هـاي مهندسـي     نقـشه ايجـاد  بـراي ترسـيم جزئيـات   كـشي و   ، يك برنامة نقشه   CSiDETAILERبرنامة  
اين برنامه، تمام عمليات .  استSAFEهاي تحليل و طراحي برنامة  هاي بتني، با استفاده از خروجي    سازه
نامة   هاي طراحي نظير آيين     نامه  هاي مورد نظر كاربر و يا مطابق آيين         فرض  از پيش كشي را با استفاده       نقشه

همچنين به منظور تطبيـق ترسـيمات بـا ديگـر     . دهد  به صورت كامل انجام ميACI 315-99ساختماني 
  . برنامه را به صورت دلخواه تغيير دادهاي توان خروجي ضوابط مي
. كنـد   ايجـاد مـي  SAFEتفاده از اطلاعات خروجـي برنامـة   ها را با اس  نقشه CSiDETAILERبرنامة  

كـاربر  بايـست توسـط        مـي   در صورت نياز   هاهاي خروجي برنامه و همچنين اصلاح آن        بررسي كل نقشه  
  بيني پيش CSiDETAILERبه منظور سهولت عمليات اصلاح، ابزارهاي گوناگوني در برنامة . انجام گيرد
 و  dxf.بـه صـورت فايلهـاي خروجـي         مات  يترس ـ ارسال   بليتقاراي  دااين، برنامه    علاوه بر . شده است 

.dwg تـوان ترسـيمات را در برنامـة           بـا اسـتفاده از ايـن قابليـت مـي          . باشد   ميAutoCAD      و يـا ديگـر 
ايــن فــصل، مــروري كلــي از برنامــة  . بــازخواني كــرده و آنهــا را ويــرايش كــردCADافزارهــاي  نــرم

CSiDETAILER دهد اده از برنامه را توضيح مي و نحوة استفداده ارائه.  
  
  طرح كلي برنامه ‐۲‐۱

 جهـت  CSiDETAILER گامهاي مختلف استفاده از برنامـة         و  جريان كلي برنامه   نمودار،  ۱‐۱در شكل   
  .هاي مهندسي شرح داده شده است ايجاد نقشه
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  CSiDETAILER ترسيمات در برنامة ايجادد  فرآين‐ ۱‐ ۱ شكل

 ،SAFE  برنامه  شامل اطلاعات خروجي طراحي    ، ترسيم نقشة مدل   براياطلاعات ورودي مورد نياز     
افـزار تحليـل و     نـرم طريـق از تـوان   را ميفرضها    اين پيش  .استهاي مختلف برنامه      فرضها و گزينه    شپي

 CSiDETAILERخروجي برنامـة    . كرد تنظيم   CSiDETAILERيا در برنامة    و  ) SAFEبرنامة  ( طراحي
در دسـترس بـودن جزئيـات       . باشـد   هاي گسترده مي     پي وها    ها، پي   شامل جزئيات كامل نقشة تيرها، دال     

برنامة تحليـل   خروجي بدست آمده از     بستگي به اطلاعات     ، CSiDETAILERدر برنامه     مختلف اجسام
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توان در   را مي اين نماها   . توان ترسيم نمود    اجسام را مي  جزئيات  نماهاي مختلفي از    . و طراحي سازه دارد   
 و  dxf.  با سـاختار   هاهمچنين امكان ذخيرة فايل   . داخل نقشه ترسيم كرده و به صورت مستقيم چاپ كرد         

.dwg وجود دارد.  
 تنظـيم  SAFE برنامـة    داخـل  از   CSiDETAILER ة برنام ـ فرضهاي  پيشابتدا  شود كه     وصيه مي ت

را اجـرا كـرده و    Detailing > Main Detailing Preferences دسـتور  ،ربراي ايـن منظـو  . گردد
  . مورد نياز را تنظيم كنيدهاي گزينه

  
  روند كلي ‐۳‐۱

هاي   ، شامل استفاده از خروجي    CSiDETAILERا استفاده از برنامة     هاي مهندسي ب    روند كلي ايجاد نقشه   
برنامـه   ي مختلف بـراي تنظـيم پارامترهـا       ايه  گزينه و سپس استفاده از       SAFEايجاد شده توسط برنامة     
 نماهاي مختلف به ترسيم     ،CSiDETAILERبرنامة  اجراي  از  پس  . كشي است   جهت هدايت روند نقشه   

در را  فرضـها     نماها و پـيش   تواند    كاربر مي . شوند  در نقشه قرار داده مي    كار   خود به صورت اضافه شده و    
 جهـت اسـتفاده در      توان به يك چاپگر فرستاد و يا        سپس خروجي نهايي را مي    . دهدصورت لزوم تغيير    

  . ذخيره كردdwg. يا dxf.با ساختار ،AutoCADبرنامة 
  :توضيح داده شده است CSiDETAILER از برنامهفرآيند مبنا براي استفاده در ادامه 

ــراي    ‐١ ــات ورودي ب ــة اطلاع ــان    :CSiDETAILERتهي ــن بي ــيش از اي ــه پ ــد چنانچ ــة ش ، برنام
CSiDETAILER هاي برنامة  هاي جزئيات مهندسي را بر مبناي خروجي     نقشهSAFE بـه  . كند  ترسيم مي

آنـرا تحليـل و   سـپس  و كـرده  اي تهيه   ابتدا بايد يك مدل سازه، براي شروع فرآيند ترسيم  عبارت ديگر، 
  .نمودطراحي 

هـاي    گزينـه  نمادهـا و انتخـاب فرضهاي ترسيم، ابعاد نقشه،     تنظيم پيش  :فرضهاي مختلف  تنظيم پيش  ‐۲
  .گيرد  صورت ميSAFE برنامة Detailingمنوي هاي موجود در  گزينهآرماتورگذاري با استفاده از 

، SAFE در برنامـة     . تنظيم كنيـد   هستندمؤثر  م  يي را كه در فرآيند ترسي     متغيرها سايرنامه و     آيين •
اي  اورهبـراي دسترسـي بـه جعبـه مح ـ     را Detailing > Main Detailing Preferences دسـتور 

Detailing Preferences از . شـود   ظـاهر مـي  ۲‐۱اي مطابق شكل  اين جعبة محاوره .اجرا كنيد
نامة طراحي، اسـتاندارد بكـار رفتـه           براي تعيين آيين   اي  جعبة محاوره اين  هاي موجود در      گزينه

 .شود اجسام مختلف طراحي استفاده ميمتناظر با  ي ابعاد و نوع مشخصة ميلگردها،براي شكل
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  Detailing Preferencesاي   جعبة محاوره‐ ۲‐ ۱شكل 

 Number Formats: اي  جعبة محاورهDimension Units and Formatting   با كليك بـرروي
تـوان     مـي   اي  جعبـة محـاوره   هاي موجود در اين       گزينهبا استفاده از    . شود  يظاهر م  اين دكمه 
  .ردها را مشخص ك واحدهاي بكار رفته در نقشهسيستم 

 Slab Detailing:  اي جعبة محاوره ،اين دكمهبرروي با كليك Slab Detailing Preferences 
 مـورد  ضوابط توان  مياي ورهجعبة محااين هاي موجود در  گزينهبا استفاده از  . شود  ظاهر مي 

 بكار رفته براي ايجاد نماهـاي دال را         ضوابطآرماتورها، قطع آرماتورها و     ترسيم  استفاده در   
 .كردمشخص 

 Beam Detailing:  اي جعبة محـاوره  ،اين دكمهبرروي با كليك Beam Detailing Options 
 مـورد  ضوابط توان  مياي اورهجعبة محاين هاي موجود در  گزينهبا استفاده از  . شود  ظاهر مي 

 بكار رفته براي ايجاد نماهـاي تيـر را       ضوابطآرماتورها، قطع آرماتورها و     ترسيم  استفاده در   
 .كردمشخص 

 Footing Detailing: اي جعبة محاوره Footing Detailing Preferences    بـرروي  بـا كليـك
 تـوان    مـي  اي  جعبـة محـاوره   ين  هاي موجود در ا     از گزينه با استفاده   . شود  ظاهر مي اين دكمه   

 بكار رفته بـراي ايجـاد       ضوابطآرماتورها، قطع آرماتورها و     ترسيم   استفاده در     مورد ضوابط
 .كرد را مشخص پينماهاي 

 Mat Detailing: اي جعبة محاوره Base Mat Detailing Preferences  ايـن  برروي با كليك
 ضوابط توان  مي اي  جعبة محاوره د در اين    هاي موجو   از گزينه با استفاده   . شود  ظاهر مي دكمه  
 بكار رفته براي ايجـاد نماهـاي        ضوابطآرماتورها، قطع آرماتورها و     ترسيم   استفاده در    مورد

 .كردپي گسترده را مشخص 
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  و ، اندازة مـتن، مرزهـا     ي، معمار ي مهندس :به عنوان نمونه  ( بندي كلي نقشه    طرحمشخص كردن    •
 اي جعبة محاوره .كنيدرا اجرا  Detailing > Drawing Setup  دستور،SAFEدر برنامة  .)حاشيه

Drawing Setup اي جعبـة محـاوره  هـاي موجـود در    از گزينه .شود ظاهر مي Drawing Setup 
 ANSI مهندسـي،    ANSI اسـتاندارد    به عنوان نمونه  (گذاري ترسيم     اندازهبراي تعيين واحدهاي    

، انـدازة  )استاندارد مهندسي، معمـاري نوان نمونه به ع( ، اندازة نقشه، نوع مقياس نقشه    )معماري
 ـ ابعاد يا مقياس نقـشه،       در صورت تغيير  . شود   استفاده مي  نقشهمتن و نمادها و مرزهاي       وي ررب

 ، و بـا دقـت  بـه سـرعت  تـا  كـرده  كليـك   Match Default Scales to Drawing Size دكمـة  
  .شوندتنظيم  ابعاد متن و نمادها ،ها هاي مربوط به مقياس نقشه گزينه

نماهاي اضافه شده به نقشه      در برخي موارد،     .مقياس نماها هنگام درج در نقشه     مشخص كردن    •
 را اجـرا  Detailing > View Placement Options دسـتور  .گيرنـد   نمـي ي جادر صفحة ترسيم

ايـن  هاي موجود در  گزينهاز . شود  ظاهر ميView Placement Options اي جعبة محاوره. كنيد
جهت جاي دادن آن برروي صفحه ترسـيم،        مقياس نما   لزوم تغيير    براي تعيين    اي  بة محاوره جع

  .شود نما در طول نقشه استفاده ميتقسيم تغيير مقياس نما و يا عدم 
 . را اجرا كنيدDetailing > Start Detailer ، دستوربراي اين منظور .CSiDETAILERبرنامة اجراي  ‐٣

همزمان با ترسيم نقشة مـدل توسـط برنامـه     ،ها ايجاد نقشه روند Detailing Statusاي  در جعبة محاوره
ايجـاد كـرده و     به صورت خودكار    هاي ممكن را      برنامه تمامي نقشه  در اين حالت،    . شود  نمايش داده مي  

  .كند آنها را به فايل پروژه اضافه مي
 اي جعبة محاوره .را اجرا كنيد File > Project Information  دستور.متن بلوك عنوانمشخص كردن  ‐۴

Project Information براي مشخص كـردن  اي  هاي موجود در اين جعبه محاوره از گزينه. شود ظاهر مي
اسـتفاده  هـاي فايـل پـروژه          بلوك عنـوان تمـامي نقـشه       ظاهر شدن آنها در     و اطلاعات مربوط به پروژه   

هـاي    نقشهتفادة اطلاعات پروژه در بلوكهاي عنوان       هايي براي اس     گزينه ،اي  جعبة محاوره  در اين    .شود  مي
  . وجود داردهاي فايل پروژه ان در تمامي نقشه كردن بلوكهاي عنوبهنگام يا وجديد 

 Options > Defineدستور  ،.dwg يا dxf. ايجاد خروجي با ساختار فايل جهت .ي نقشهها لايهتنظيم  ‐۵

View Layers اي جعبة محاوره .را اجرا كنيدLayer List  بـراي  اي جعبـة محـاوره   از اين .شود ظاهر مي 
 فايـل   ه در  اسامي آنها جهت ذخير    ،ها   لايه عنوان. شود ميها استفاده      لايه عنواناضافه، اصلاح و يا حذف      

  . استdwg. يا dxf.با ساختار
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  دسـتور  .هـا    نوع خط جهت ترسيم نقشه و تخصيص اجسام بـه لايـه            ،ضخامت خط مشخص كردن    ‐٦
Options > Drawing View Optionsاي جعبة محاوره . را اجرا كنيد View Options  از .شـود  مي ظاهر 

 General ،Slab/Mat Plan ،Slab/Mat Sections ،Beams، Footingsشش برگـة  در هاي مختلف  گزينه
 : نمونـه به عنوان( و نوع  )قلم پهناي خط يا اندازة      به عنوان نمونه  ( براي تعيين رنگ، ضخامت      Tables و

 مختلف بكار رفته براي بـه   موضوعات) قلم يا خوابيده براي     ضخيم حالت   ،براي خطوط  نقطه نقطهخط  
هر برگـه   . شود  فاده مي تاسهاي چاپ شده      يا خروجي و    ناحية نمايش  تصوير كشيدن نماها و جداول در     

همچنين هر برگه  .وجود دارند ايجاد قابل  مختلف فهرست موضوعات،در آنيك ناحية نمايش دارد كه   
 را انتخـاب  از فهرسـت  موضوع يك .باشد  ميdxf/dwg Export Layer forداراي يك فهرست كشويي 

 بـراي  Layer for dxf/dwg Exportنام لايـه را در فهرسـت كـشويي     نمايش و هاي  هكنيد و سپس گزين
 ،هـاي نمـا      گزينـه  نظيمت از   پس.  مشخص كنيد  dwg. يا   dxf.فايل   با ساختار فايل پروژه   در  كردن   ذخيره

 مجـدداً بـازخواني     هچنانچه فايـل پـروژ     و    بوده رث مؤ  باشند،  تغيير داده نشده  هنگامي كه   تا  اين تنظيمات   
  .گردند اعمال ميشود 

 بهنگامها را     نقشهجهت نمايش تغييرات اعمال شده،      . تغييرات لازم اعمال  نقشة ايجاد شده و     بازبيني   ‐٧
 دسـتيابي بـه     وهـا     براي كار با نقـشه    ،  Tables  و Edit  ،Drawingي  ها منو رهاي موجود د    گزينهاز   .كنيد

  .نتايج مطلوب استفاده كنيد
 را بـا    تـك يك نمـاي    . دنآنها انتخاب شده باش   ابتدا بايد    نماها،برروي   يعملياتقبل از انجام هر     

 بـا كليـك   نما را با ترسيم يك پنجره پيرامون آنهـا يـا  چند . آن انتخاب كنيدبرروي كليك كردن   
  .نماييدتك تك آنها انتخاب برروي كردن 

 را View > Refresh Viewترسيمات توسط برنامـه، دسـتور   خودكار سازي  بهنگامدر صورت عدم 
  . شودبهنگامها، بلوك عنوان يا آرايش نماها  گزينهاجرا كنيد تا تغييرات مربوط به 

 و در بررسـي كـرده   را CSiDETAILER توسـط برنامـه   شده    هاي توليد    نقشه بايد به دقت  كاربر  
  .صورت لزوم آنها را اصلاح كند

جعبـة   . را اجـرا كنيـد  File > Print Drawings  دسـتور .ي ايجاد شـده ها نقشهايجاد كپي پشتيبان از  ‐٨
، نـوع  اي جعبة محاورهاين هاي موجود در  گزينه با استفاده از .شود مي ظاهر  Print Drawingsاي محاوره

هـا و يـا    نقشة جاري، تمام نقشه( دني را كه بايد چاپ شو    يها  گيري آن و نقشه      كاغذ، جهت  چاپگر، ابعاد 
  .مشخص كنيد) هاي انتخابي نقشه
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 . ذخيـره كنيـد    CADهـاي      برنامه با ساختار ها نياز به اصلاحات تكميلي داشتند، آنها را           نقشهچنانچه   ‐۹
  Export Drawingsاي عبـة محـاوره  ج . كنيد را اجراFile > Export Drawings، دستور براي اين منظور

هـايي را    فايل و نقشهساختار، نوع اي جعبة محاورهاين هاي موجود در      گزينه با استفاده از     .شود ميظاهر  
  .مشخص كنيد) هاي انتخابي ها و يا نقشه نقشة جاري، تمام نقشه( دنكه بايد ذخيره شو

 SAFEطراحـي در برنامـة      ل تحليل يـا     چنانچه مد  ،CSiDETAILERدر صورت اجراي برنامة     
بـراي  . شـود   ظاهر مي  تغييرات   اعلاماي    جعبة محاوره ،  )قفل نباشد تي كه مدل    در حال ( تغيير كند 

 را انتخـاب  Retain Current Drawings and Options هاي قبلـي، گزينـة    و نقشهجزئيات حفظ
فرضـهاي    نتـايج طراحـي و پـيش      ا   شدن تغييرات مطابق ب    بهنگام برنامه و    اجراي به منظور . كنيد

 بـرروي  عمـل ايـن  .  را انتخـاب كنيـد  Rerun Detailing and Update Drawingsجديد، گزينة 
هاي جديـد     براي ترسيم مجدد نقشه   . ثيري نخواهد داشت  أ شده در نقشه ت    انجامنماهاي مختلف   

Rerun فرضـها و آخـرين تغييـرات اعمـال شـده در خروجـي طراحـي، گزينـة          مطابق با پـيش 

Detailing and Generate New Drawingsدر صورت انتخـاب ايـن گزينـه   .  را انتخاب نماييد، 
  .حذف خواهند شدها و اطلاعات قبلي  فرض تمامي تنظيمات و پيش

  
  كشي مدل تحليلي و نقشه ‐۴‐۱

  و SAFE هـاي    برنامـه  كـشي را بـا اسـتفاده از         هشروند توضيح داده شده در بخش قبل، فرآيند كلـي نق ـ          
CSiDETAILER هـاي جديـد      شود، نقشه   يك مدل جديد ترسيم مي    جزئيات   هنگامي كه  .دهد  رح مي ش

. دنشـو   ترسـيم مـي  SAFE برنامـة  Detailingفرضهاي تنظـيم شـده در منـوي      ها و پيش    بر اساس گزينه  
پـيش  هـاي     ها با اسـتفاده از گزينـه        فرضي توسط كاربر تنظيم نشده باشد، تمامي نقشه          هيچ پيش  چنانچه
براي دسترسي به اين پيش  را Detailing > Main Detailing Preferenceدستور . شوند مي ترسيم فرض
 < Options دستورفرضهاي ترسيم را با استفاده از  توان پيش ها مي  نقشهايجاداز پس . ها اجرا كنيد فرض

Main Detailing Preference در برنامــة CSiDETAILERــا اجــراي مجــ ســپس.  اصــلاح كــرد دد ب
  .نمودها اعمال   تغييرات را به نقشه،ترسيمات
 در  هـاي موجـود     ههاي ترسيم، همراه با اصلاحات مختلفي كه به نقش           تمامي نماها و گزينه    اتتنظيم

 ة برنام ـ اجـراي مجـدد    از   پـس . شـوند   مـي شـود، در برنامـه ذخيـره           اعمال مي  CSiDETAILERبرنامة  
CSiDETAILER    هـا را مطـابق آن        و نقـشه  جايگزين كـرده     راكاربر  ط  توساعمال شده   ، برنامه تغييرات
  .دهد تغييرات نمايش مي



  SAFE- CSiDETAILERآرمه  هاي بتن تحليل و طراحي دالها و پي  ١٠

 هاي ترسيم با اسـتفاده از دسـتور   فرض  تغيير كند يا پيش  SAFE مدل تحليل و طراحي در برنامة        اگر
Main Detailing Preference Detailing >ة  در برنامSAFEبرنامه د، ن اصلاح شوCSiDETAILER در 

جعبـة  در  را   تغييرات   فهرست و   دادهاخطار  به كاربر    اعمال شده     تغييرات دد در مورد   مج يصورت اجرا 
قبل از هايي را كه  نقشهمحتويات تواند  سپس كاربر مي. دهد  نمايش ميModification Alert اي محاوره
برنامـه   يا اينكه  و   كند بهنگامرا  مورد نظر   تغييرات  تنها  جرا كرده و    را ا برنامه   و   داشتهاند نگاه      شده ايجاد

شود كه در صـورت تغييـر،         توصيه مي  اين وجود با  . مجدداً توليد كند   جديد را  يها   و نقشه  را اجرا كرده  
  . ترسيم شونددوبارهها  مجدداً اجرا شده و نقشه  CSiDETAILER ةبرنام








